
GETTING STARTED

NI 9501 C Series Stepper Drive 
Modules and NI SoftMotion Module

Note If you are a new user of LabVIEW or are unfamiliar with LabVIEW, refer to 
the Getting Started with LabVIEW manual for information about LabVIEW and 
LabVIEW terminology.

This document explains how to use an NI 9501 C Series drive module with LabVIEW 
NI SoftMotion Module User-Defined Variable (UDV) axes, using an NI 9501 C Series drive 
module example to demonstrate concepts and programming best practices.

Tip If you encounter any problems during setup, refer to the Tips and 
Troubleshooting section for assistance.
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What You Need to Get Started
You need the following items to get started.

Hardware
 NI 9501 C Series stepper drive module

 NI CompactRIO real-time controller and chassis

 24 V power supply (such as the NI PS-15) for the CompactRIO controller 
(NI part number 781093-01)

 24 V power supply (such as the NI PS-16) for the NI 9501 module and NI 9411 module 
(if connecting an encoder)
(NI part number 781094-01)

Note NI recommends the NI PS-16 power supply, which is designed for motor bus 
power, for use with the NI 9501 module. Refer to Regeneration Consideration Using 
the NI C Series Drive Modules at zone.ni.com for more information.

 Ethernet connection and cable for the CompactRIO controller

 NI or third-party stepper motor

Note NI offers NEMA 17 and NEMA 23 stepper motors compatible with the 
NI 9501. Go to ni.com for more information.

Optional Hardware
 NI or third-party encoder

Note NI offers encoders for NEMA 23 stepper motors. Go to ni.com for more 
information.

 NI 9411 digital input module for encoder connections
(NI part number 779005-01)

 NI 9935 15-pin D-SUB connector kit for connecting the NI 9411
(NI part number 779016-01)

 NI 9401 high-speed bidirectional digital I/O module for position compare and position 
capture operations
(NI part number 779351-01)

 NI 9924 25-pin D-SUB connector kit for connecting the NI 9401
(NI part number 781922-01)
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 NI 9423 sinking digital input module for home, limit, and digital input connections
(NI part number 779009-01)

 NI 9472 sourcing digital output module for digital output connections
(NI part number 779004-01)

Software
 LabVIEW 2012 SP1 or later

 LabVIEW 2012 SP1 Real-Time Module or later

 LabVIEW 2012 SP1 FPGA Module or later

 LabVIEW 2012 SP1 NI SoftMotion Module or later

 NI-RIO Device Drivers 2012 or later

Figure 1 shows the system setup without optional hardware. The Setting Up and Using Optional 
Hardware section discusses optional hardware, including a connection diagram and example 
walkthrough of optional functionality.

Figure 1.  NI SoftMotion Module with NI 9501 UDV Axis System Overview
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NI SoftMotion Module Overview
NI SoftMotion Module UDV axes allow you to implement an interface for communication 
between the NI SoftMotion Engine and the LabVIEW FPGA Module. This is achieved using 
user-defined variables that you add to the project, making it easier to use C Series modules in 
FPGA mode with the NI SoftMotion Module. 

The following figure shows the NI SoftMotion architecture when you use the NI SoftMotion 
Module with UDV axes and the LabVIEW FPGA Module.

Figure 2.  NI SoftMotion Module with UDV Axes

You use the LabVIEW Project to configure your axis settings and test your configuration. When 
your hardware configuration is complete, you use NI SoftMotion APIs to create move profiles. 

Communication to the LabVIEW FPGA Module is handled through user-defined variables. You 
use the NI SoftMotion Drive Interface VIs to implement an interface for communication 
between the NI SoftMotion Engine and the LabVIEW FPGA Module. When you use the Drive 
Interface VIs with UDV axes you communicate using a predefined set of UDVs. Refer to Adding 
User-Defined Variables for Use With a UDV Axis in the NI SoftMotion Module Help, available 
by selecting Help»LabVIEW Help for information about the predefined UDVs. Refer to the 
Using NI 9501 with NI SoftMotion section for more information about the NI SoftMotion Drive 
Interface VIs.
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Hardware and Software Installation
This section covers the hardware and software setup for the CompactRIO system and NI 9501 
C Series drive module. Refer to the Setting Up and Using Optional Hardware section for 
information about connecting additional hardware.

Step 1: Set Up the CompactRIO System
Complete the following steps to set up the CompactRIO hardware.

1. Install the real-time CompactRIO controller on the chassis if you are not using an integrated 
controller and chassis. 

Note Write down the controller serial number before installing the controller onto 
the chassis. You will be unable to read the serial number after you install the 
controller.

a. Make sure that no power is connected to the controller or the chassis.

b. Align the controller with the chassis as shown in Figure 3. 

Figure 3.  Installing the Controller on the Chassis (Eight-Slot Chassis Shown)
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c. Slide the controller onto the controller slot on the chassis. Press firmly to ensure the 
chassis connector and the controller connector are mated. 

d. Using a number 2 Phillips screwdriver, tighten the two captive screws on the front of 
the controller.

2. Connect the controller to a power supply and an Ethernet network on the same subnet as 
the development computer. Refer to the controller operating instructions for information 
about wiring the controller to the power supply and Ethernet network.

Note Do not plug in or turn on any power to the system until after all hardware 
connections are complete.

3. Install the NI 9501 module in slot 1 of the chassis, if available. 

Note The NI 9501 example programs are configured for slot 1. If the NI 9501 
module is installed in a different slot, modify the examples accordingly. 

Step 2: Connect NI 9501 to the Stepper Motor
1. Connect the stepper motor to the NI 9501. Figure 4 shows a typical bipolar stepper motor 

connection. Refer to the NI 9501 Operating Instructions and Specifications for important 
connection information, including information about EMC compliance and connecting 
6- or 8-wire stepper motors.

Figure 4.  NI 9501 Bipolar Stepper Motor (2-Phase Type) Connection

NEMA 17 and NEMA 23 stepper motors from NI use the following wire color scheme.

Figure 5.  Stepper Motor Wiring
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Step 3: Connect the NI 9501 to the NI PS-16 
Power Supply

Tip Refer to the NI PS-16 Power Supply User Manual and Specifications for more 
information about connecting and using the NI PS-16 power supply.

Complete the following steps to connect the NI 9501 module to the NI PS-16 power supply.

Tip Refer to the NI 9501 Operating Instructions and Specifications for more 
information about module power supply requirements.

1. Connect the NI 9501 Vsup (pin 8) to one of the two (+) terminals on the NI PS-16. 

2. Connect the NI 9501 COM (pin 7) to one of the two (-) terminals on the NI PS-16.

3. Connect the power supply to AC power.

Step 4: Connect the System to AC Power
Complete the following steps to power on the system.

1. Connect the controller power supply to AC power.

2. Connect the NI 9501 power supply to AC power.

Step 5: Install Software on and Configure the 
NI RT Controller
This step covers installing and configuring the software for the NI 9501 stepper drive module. 
It assumes that all required software from the What You Need to Get Started section is installed 
on the host machine.

Complete the following steps to configure the controller and install software on it.

Note The Measurement & Automation Explorer (MAX) user interface may not 
match these steps exactly depending on which version of MAX you are using. 

1. Launch Measurement & Automation Explorer (MAX) on the development computer by 
double-clicking the MAX icon on the desktop ( ), or by selecting Start»
All Programs»National Instruments»Measurement & Automation.

2. Expand the Remote Systems tree.

3. Highlight your device.

Note If you do not see the controller, you may need to disable the firewall on the 
development computer. Go to ni.com/info and enter RIOMAXTroubleshoot 
for more information.
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4. Verify that the Serial Number in the General Settings section matches the serial number 
on the device.

5. If you do not want to format the disk on the controller, eliminating all installed software and 
files, skip to step 15.

6. Set the Safe Mode switch on the controller to the On position.

Note If your controller supports the Attempt to restart into safe mode option, you 
can programmatically enable safe mode rather than using the hardware switch and 
skip to step 8.

7. Power on the controller. If it is already powered on, press the Reset button on the controller 
to reboot it.

8. Right-click the controller under Remote Systems in the configuration tree in MAX and 
select Format Disk. 

9. (Optional) Enable either the Preserve the primary adapter settings and disable the 
others or Preserve the settings for all network adapters options if you want to retain the 
same target name and IP address and retain settings for the secondary network adapter, if 
available. 

10. Click Format to start formatting the disk.

11. When MAX finishes formatting the disk, set the Safe Mode switch to the Off position 
(if necessary) and click OK in the confirmation dialog box.

12. Select the System Settings tab on the bottom and type a descriptive name for the system in 
the Hostname field.

13. (Optional) Complete this step only if the target has an empty IP address (0.0.0.0). Select the 
Network Settings tab and select DHCP or Link Local from the Configure IPv4 Address 
list to assign an IP address or select the Static to specify a static IP address in the IPv4 
Address section.

14. Click Save on the toolbar and let MAX reboot the system. You may not need to complete 
this step if you did not change the IP address or name.

15. When the new system name appears under Remote Systems, expand the controller item in 
the tree, right-click Software, and select Add/Remove Software.

16. Select a recommended software set that includes NI-RIO 2012 or later. Click Help if you 
need information about installing recommended software sets.

17. Click Next.

18. Select LabVIEW NI SoftMotion Module from the add-ons list.

19. Click Next to install the selected software on the controller. 

20. When the software installation completes, click Finish to reboot the controller.

21. Make a note of the IP address assigned to the controller, to use when adding the target in 
LabVIEW.

22. Close MAX.
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Using NI 9501 with NI SoftMotion
The following tutorial walks you through using an NI 9501 UDV axis using the Stepper 
Drive (Getting Started) example installed in the <labview>\examples\motion\
UDV\Stepper Drive (Getting Started) directory. This example shows how to 
configure the NI 9501 for a UDV axis using the LabVIEW project and contains all required 
UDVs for use with the NI 9501. 

Note NI SoftMotion FPGA examples are configured with a cRIO-9074 chassis. Go 
to ni.com/info and enter fpgaex for information about how to move the example 
to a different FPGA target. 

1. Open Stepper Drive (Getting Started).lvproj.

2. Right-click the RTTarget item in the Project Explorer window and select Properties 
from the shortcut menu to open the real-time target properties dialog box.

3. On the General page, enter the IP address you configured in Step 4: Connect the System to 
AC Power. 

4. Click OK.

5. Right-click the target and select Connect from the shortcut menu. The RT target icon in the 
Project Explorer window changes to indicate a front panel connection with the RT target.

NI SoftMotion UDV Axes and Configuration Data
This section describes each UDV used in the example and explains how module configuration 
data is communicated from the LabVIEW Project to the LabVIEW FPGA Module.

1. Expand the RTTarget item in the Project Explorer window.

2. Expand the Chassis item, then expand the User-Defined Variables item to display the 
UDVs used in the example. Figure 6 shows the LabVIEW Project with the UDVs 
displayed.
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Figure 6.  Stepper Drive (Getting Started) User-Defined Variables

The following table briefly describes each UDV used in the project. Refer to Adding 
User-Defined Variables for Use With a UDV Axis in the NI SoftMotion Module Help for more 
information about each UDV.

Table 1.  Stepper Drive (Getting Started) UDV Descriptions

UDV Name Description

Axis 1.Control Register Contains information used to control the state and operating 
mode of the device. 

Axis 1.Mailbox 
(FPGA to Host)

Contains information used to provide configuration and 
other data from FPGA to the NI SoftMotion Engine.

Axis 1.Mailbox
(Host to FPGA)

Contains information used to provide configuration and 
other data from the NI SoftMotion Engine to FPGA.

Axis 1.Position Setpoint Specifies the position setpoint.
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NI SoftMotion Engine to FPGA Communication
Each User-Defined Variable communicates information between the NI SoftMotion Engine and 
the LabVIEW FPGA Module. These UDVs are used directly with the Drive Interface FPGA VIs 
in specific loops on the block diagram. Complete the following steps to open the FPGA VI and 
display the block diagram.

1. Expand the FPGA Target item in the LabVIEW Project Explorer window.

2. Double-click the Stepper Drive (Getting Started) - FPGA.vi item to open the VI.

3. Select Window»Show Block Diagram to open the FPGA VI block diagram.

Fault Monitoring Loop
The Fault Monitoring loop sends fault information, including user-defined faults, to the 
NI SoftMotion engine and sends the state machine implemented in the Control Status Loop into 
a fault state. Figure 7 shows the Fault Monitoring Loop from the Stepper Drive (Getting Started) 
example.

Figure 7.  Stepper Drive (Getting Started) Fault Monitoring Loop

Axis 1.Status Register Contains information used to report status and operation 
mode information from the device to the system. 

Axis 1.Steps Generated Returns the current step count of the stepper generator 
taking into account the direction. This value is based on 
actual steps generated, not feedback position, and may not 
exactly match the feedback position.

1 Fault Code Array 2 Write Fault Drive Interface VI

Table 1.  Stepper Drive (Getting Started) UDV Descriptions (Continued)

UDV Name Description

1 2
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Control Status Loop
The Axis 1.Control Register and Axis 1.Status Register UDVs are used in the Control Status 
Loop. Figure 8 shows the Control Status Loop from the Stepper Drive (Getting Started) 
example.

Figure 8.  Stepper Drive (Getting Started) Control Status Loop

The Control Status Loop interprets the Control Register UDV and recognizes state changes, 
executes the appropriate action on a state change, and generates the Status Register UDV that 
returns information to the NI SoftMotion Engine.

Review the operations that occur at each transition inside the State Change Case structure. The 
Interpret Control Register and Generate Status Register topics in the NI SoftMotion Help 
describe the valid state transitions and which operations should occur in each state. 

1 Axis 1.Control Register UDV
2 Interpret Control Register Drive Interface VI
3 State Change Case Structure

4 Generate Status Register Drive Interface VI
5 Axis 1.Status Register UDV

1 2 3 4 5
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Reset Monitoring Loop
The Reset Monitoring Loop latches the reset variable so that it only changes on a rising edge of 
the Scan Clock. This allows proper operation of the NI SoftMotion Motor Control VIs with a 
reset input. Figure 9 shows the Stepper Drive (Getting Started) Reset Monitoring Loop.

Figure 9.  Stepper Drive (Getting Started) Reset Monitoring Loop

Mailbox Loop
The Axis 1.Mailbox (FPGA to Host) and Axis 1.Mailbox (Host to FPGA) UDVs are used in the 
Mailbox Loop. Figure 10 shows the Mailbox Loop from the Stepper Drive (Getting Started) 
example.

Figure 10.  Stepper Drive (Getting Started) Mailbox Loop

The Mailbox Loop transfers axis configuration and other data between the NI SoftMotion 
Engine and the LabVIEW FPGA Module. The transferred data is written to FPGA memory and 
accessed using the Read Motion Memory and Write Motion Memory Drive Interface VIs. This 
loop is required to be implemented as-is for proper operation. 

1 Scan Clock 

1 Axis 1.Mailbox (Host to FPGA) UDV
2 Mailbox Handler Drive Interface VI

3 Axis 1.Mailbox (FPGA to Host) UDV

1

1 2 3
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Synchronization Loop
The Synchronization Loop synchronizes the FPGA clock (slave) to the RT clock (master) to 
correct for drift and jitter. This is the preferred synchronization method to use with the 
NI SoftMotion Module. Figure 11 shows the Synchronization Loop from the Stepper Drive 
(Getting Started) example.

Figure 11.  Stepper Drive (Getting Started) Synchronization Loop

The Synchronization Loop is required to be implemented as-is for proper operation. Refer to the 
Synchronization VIs section of the NI SoftMotion Module Help for more information. 

Position Loop and Step Generation Loop
The Axis 1.Position Setpoint UDV is used in the Position Loop. Figure 12 shows the Position 
Loop from the Stepper Drive (Getting Started) example.

Figure 12.  Stepper Drive (Getting Started) Position Loop

The Position Loop receives position setpoints from the NI SoftMotion trajectory generator and 
uses the Spline Interpolation VI to generate intermediate setpoints, resulting in smoother motion. 
The Position Loop receives input from the Synchronization Loop as well as timing information 
calculated by the NI SoftMotion Engine. This timing information is provided to divide down the 
Scan Clock evenly to run the position loop at the user-specified stepper Position Loop Period.

1 NI SoftMotion Scan - Generate Sync Scan Synchronization VI

1 Synchronization Inputs
2 NI SoftMotion Scan - Loop Timer VI
3 Spline Configuration Information from NI SoftMotion

4 Axis 1.Position Setpoint UDV
5 Spline Interpolation Motor Control VI

1

1 2 3 4 5
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The Position Loop sends interpolated position points to the Step Generation Loop, shown in 
Figure 13. 

Figure 13.  Stepper Drive (Getting Started) Step Generation Loop

The Step Generation Loop uses the Position Step Frequency Modulation Motor Control VI to 
convert the interpolated position points to Step and Direction signals and returns the steps 
generated so that this information can be sent to the NI SoftMotion Engine.

Compile and Run the Example
Complete the following steps to compile and run the example.

1. Right-click the axis in the Project Explorer window and select Properties from the shortcut 
menu to open the Axis Configuration dialog box. The Axis Configuration dialog box 
includes configuration options for stepper drive command signals, feedback devices, 
motion and digital I/O, trajectory, and axis setup. 

1 Minimum Pulse Width from NI SoftMotion Configuration
2 Interpolated Position from Position Loop
3 Position Step Frequency Modulation Motor Control VI

4 NI 9501 Step and Direction Signals
5 Axis 1.Steps Generated UDV

2 3 4 51
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Figure 14 shows the parts of the Axis Configuration dialog box for NI 9501 UDV axes. 
Refer to the NI SoftMotion Module section of the LabVIEW Help for detailed information 
about each configuration option.

Figure 14.  Axis Configuration Dialog Box for NI 9501 UDV Axes

Note The Axis Configuration dialog box user interface may not match this image 
exactly depending on which version of the LabVIEW NI SoftMotion Module you are 
using.

2. Click the Motor button ( ) and set the Rated Phase Current to the appropriate value 
for your motor in Amps/Phase. Use the motor datasheet and the type of motor connection 
used to determine this setting based on the following table.

3. Click OK to close the Axis Configuration dialog box.

4. Right-click the Chassis item in the Project Explorer window and select Deploy from the 
shortcut menu. 

Table 2.  NI 9501 Rated Phase Current Setting

Connection Type Rated Phase Current (Amps/Phase)

Bipolar 4-wire same as datasheet Amps/Phase

6-wire series datasheet Amps/Phase × 0.707

6-wire half-coil same as datasheet Amps/Phase

8-wire series datasheet Amps/Phase × 0.707

8-wire parallel datasheet Amps/Phase × 1.414

8-wire half coil same as datasheet Amps/Phase
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5. Click the Run button on the Stepper Drive (Getting Started) - FPGA.vi. 
Clicking the Run button compiles the VI only if the VI or project has changed since you 
last compiled the VI. 

Note The compilation process goes through several stages. Compiling FPGA VIs 
can take from a few minutes to a few hours. National Instruments recommends 
testing and debugging an FPGA VI before you compile it. Refer to Introduction to 
Debugging FPGA VIs on an FPGA Target in the FPGA Module Help for more 
information.

6. Verify that the FPGA VI is running. When a VI runs, the Run button ( ) changes to a 
darkened arrow ( ) to indicate that the VI is running. If the VI is not running, press the 
Run button.

7. Right-click the axis in the Project Explorer window and select Interactive Test Panel 
from the shortcut menu. 

Tip Click the Help button ( ) on the bottom of the dialog box for detailed 
information about the items available in this dialog box.

8. Click the Enable button ( ) on the bottom of the dialog box to enable the drive.

9. Click the Start button ( ) on the bottom of the dialog box to start the move with the 
configured options. If you encounter any errors or faults, refer to the Tips and 
Troubleshooting section for possible solutions.

10. Use the Status and Plots tabs to monitor the move while it is in progress.

11. Click the Stop button ( ) to stop a move in progress.

12. Click the Disable button ( ) on the bottom of the dialog box to disable the drive when 
you are finished testing it.
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Setting Up and Using Optional Hardware
This section describes how to configure and use the NI 9501 with additional hardware to provide 
encoder feedback, limit and home inputs, digital I/O, and compare and capture operations. The 
Stepper Drive (with Encoder) example contains four additional modules and additional UDVs 
and FPGA loops to support these operations. Figure 15 shows the system setup with the 
additional hardware.

Figure 15.  NI SoftMotion Module with NI 9501 UDV Axis System Overview

Table 3 shows the additional modules and what they are used for in the Stepper Drive (with 
Encoder) example.

Table 3.  Additional C Series Modules Used in the Stepper Drive (with Encoder) Example

C Series Module
Slot 

Number Purpose

NI 9423 Sinking Digital Input 
Module

2 Limits, Home, and Digital Inputs

NI 9472 Sourcing Digital Output 
Module

3 Digital Outputs

NI 9401 High-Speed Bidirectional 
Module

4 Position Compare and Position Capture

NI 9411 Digital Input Module 5 Encoder Inputs

Feedback 
Connections

Ethernet
Cable

Motor Connections

NI RT Controller 
(NI 9074 shown)

with C Series Modules

+24 V Power Supply
(NI PS-15 Shown)

9 to 30 V Power Supply
(NI PS-16 Shown)

Stepper Motor 
and Encoder

Limit, Home, and Digital Input Connections

Digital Output Connections

Compare and Capture Connections
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Adding and Connecting Additional Modules

Add and Connect an NI 9423 Digital Input Module
1. Install and connect an NI 9423 digital input module in slot 2 of the chassis.

2. Connect the forward, reverse, and home switch to the NI 9423 as follows:

3. Connect additional digital inputs to the following channels.

Add and Connect an NI 9472 Digital Output Module
1. Install and connect an NI 9472 digital output module in slot 3 of the chassis.

2. Connect digital output devices to the NI 9472. 

3. Connect the NI 9472 to the NI PS-16 power supply.

a. Connect an available NI 9472 Vsup terminal to one of the two (+) terminals on the 
NI PS-16. 

b. Connect an available NI 9472 COM terminal to one of the two (-) terminals on the 
NI PS-16

Table 4.  NI 9411 Limit and Home Connections

NI 9423 Signal Function

DI5 Reverse Limit

DI6 Forward Limit

DI7 Home Switch

Table 5.  NI 9411 Digital Input Connections

NI 9423 Signal Function

DI0 Digital Input 0

DI1 Digital Input 1

DI2 Digital Input 2

DI3 Digital Input 3

DI4 Digital Input 4
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Add and Connect an NI 9401 High-Speed Bidirectional Module
1. Install and connect an NI 9401 digital I/O module in slot 4 of the chassis.

2. Connect the position compare and position capture signals as follows:

Add and Connect an NI 9411 Digital Input Module
1. Install an NI 9411 digital input module in slot 5 of the chassis.

2. Connect the encoder to the NI 9411. The NI 9411 also provides a +5 V supply for encoder 
power. The Stepper Drive (with Encoder) example uses the following NI 9411 signals for 
the corresponding encoder signals.

3. Connect the NI 9411 to the NI PS-16 power supply.

a. Connect the NI 9411 Vsup terminal to one of the two (+) terminals on the NI PS-16. 

b. Connect the NI 9411 COM terminal to one of the two (-) terminals on the NI PS-16.

Table 6.  NI 9401 Position Capture and Position Compare Connections

NI 9401 Signal Function

DIO0 Position Capture Input

DIO4 Position Compare Output

Table 7.  NI 9411 Encoder Connections

NI 9411 Signal Encoder Signal

DI0 Encoder Phase A

DI1 Encoder Phase B

DI2 Encoder Index
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Additional UDVs and FPGA VI Loops
The Stepper Drive (with Encoder) example contains several additional UDVs and loops to 
implement the new functionality. In addition to the UDVs described in Table 1, the Stepper 
Drive (with Encoder) example uses the following new UDVs. Refer to Adding User-Defined 
Variables for Use With a UDV Axis in the NI SoftMotion Module Help for more information 
about each UDV.

Table 8.  Stepper Drive (with Encoder) Additional UDV Descriptions

UDV Name Description

Axis 1.DIO Control (Port A) Contains the values of digital outputs 0 through 3 as well as 
information to clear input latches for limits, home, and 
digital inputs 0 through 3.

Axis 1.DIO Control (Port B) Contains the values of digital outputs 4 through 7 as well as 
information to enable position compare and position 
capture operations and clear input latches for digital inputs 
4 through 7.

Note Because the same digital input module is 
used for digital inputs and for home and limit 
connections, the Stepper Drive (with Encoder) 
example only uses digital inputs 0 through 4. Digital 
inputs 5 though 7 are not used in the example.

Axis 1.DIO Status (Port A) Contains information used to report value and latching 
information for limits, home, and digital inputs 0 through 3.

Axis 1.DIO Status (Port B) Contains information used to report value and latching 
information for position capture, position compare, and 
digital inputs 4 through 7.

Axis 1.Position Feedback Specifies the feedback position from the encoder.

Axis 1.Velocity Feedback Returns the filtered encoder velocity.
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Position Loop
Figure 16 shows the Position Loop from the Stepper Drive (with Encoder) example.

Figure 16.  Stepper Drive (with Encoder) Position Loop

When used with encoder feedback, the Position Loop calculates interpolated positions, filters the 
encoder velocity using the user-specified filter settings, and returns the feedback position and 
filtered velocity feedback information to the NI SoftMotion Engine.

1 NI SoftMotion Scan - Loop Timer VI
2 Encoder Configuration Information from NI SoftMotion
3 Axis 1.Position Setpoint UDV
4 FPGA Butterworth Filter VI

5 Spline Interpolation Motor Control VI
6 Axis 1.Position Feedback UDV
7 Axis 1.Velocity Feedback UDV

71 3 4 5 62
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Encoder Loop
Figure 17 shows the Encoder Loop from the Stepper Drive (with Encoder) example.

Figure 17.  Stepper Drive (with Encoder) Encoder Loop

The encoder loop uses the signals from the NI 9411 module to generate position and velocity 
feedback. Position Capture operations are included in the encoder loop to perform the Index 
capture operation for use with the NI SoftMotion Find Index routine.

1 Encoder Configuration Information from 
NI SoftMotion

2 Encoder Input Signals

3 Incremental Encoder Decoder Motion Control VI
4 Position Capture Motor Control VI

1 42 3
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DIO Config Port A Loop
Figure 18 shows the DIO Config Port A loop from the Stepper Drive (with Encoder) example.

Figure 18.  Stepper Drive (with Encoder) DIO Config Port A Loop

The DIO Config Port A loop manages the DIO contained in DIO Port A. This includes the 
Forward Limit, Reverse Limit, Home Switch, and Digital Inputs 0 though 3 from the NI 9423 C 
Series module, and Digital Outputs 0 through 3 that are sent to the NI 9472 C Series module.

1 Axis 1.DIO Control (Port A)
2 DIO Port A Configuration Information from 

NI SoftMotion
3 Limit, Home, and Digital Input 0 through 3 Signals
4 Interpret DIO Control (Port A) Drive Interface VI

5 Digital Filter Motor Control VI
6 Generate DIO Status (Port A) Drive Interface VI
7 Axis 1.DIO Status (Port A)
8 Digital Output 0 through 3 Signals

1 52 3 4 6 7 8
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DIO Config Port B Loop
Figure 18 shows the DIO Config Port B loop from the Stepper Drive (with Encoder) example.

Figure 19.  Stepper Drive (with Encoder) DIO Config Port B Loop

The DIO Config Port B loop manages the DIO contained in DIO Port B. This includes the 
Position Capture Input and Position Compare Output from the NI 9401 C Series module, Digital 
Inputs 4 though 7 from the NI 9423 C Series module, and Digital Outputs 4 through 7 that are 
sent to the NI 9472 C Series module.

Tips and Troubleshooting

Drive Fault on Enable
If you receive fault 7180 when you enable the NI 9501, verify that the Rated Phase Current 
setting is set to the appropriate value for your motor in Amps/Phase. Refer to Table 2 for 
information about how to determine this value.

Complete the following steps to correct the setting:

1. Set the Rated Phase Current in the Axis Configuration dialog box and click OK when 
you are done.

2. Right-click the axis in the Project Explorer window and select Deploy from the shortcut 
menu to deploy the updated setting.

1 Axis 1.DIO Control (Port B)
2 DIO Port B Configuration Information from 

NI SoftMotion
3 Digital Input 4 through 7 and Position Capture 

Input Signals
4 Interpret DIO Control (Port B) Drive Interface VI

5 Digital Filter Motor Control VI
6 Digital Output 4 through 7 Signals 
7 Position Capture Motor Control VI
8 Position Compare Motor Control VI
9 Position Compare Output Signals
10 Generate DIO Status (Port B) Drive Interface VI

1 53 4 6 7 8 9 102
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Where to Go Next
The following documents contain additional information that you may find helpful. All 
referenced documents ship with the product and are available at ni.com/manuals.

• Operating instructions for the controller

• NI 9501 Operating Instructions and Specifications—Use this document to learn how to use 
the National Instruments 9501, including specifications and pin assignments for the 
NI 9501.

• NI 9411 Operating Instructions and Specifications—Use this document to learn how to use 
the National Instruments 9411, including specifications and pin assignments for the 
NI 9411.

• LabVIEW NI SoftMotion Module Help—Use this help file to learn about using the 
NI SoftMotion Module in LabVIEW including information about function blocks and 
using the NI SoftMotion Module with the LabVIEW Project. To access this help file from 
LabVIEW, select Help»LabVIEW Help, then expand the LabVIEW NI SoftMotion 
Module book on the Contents tab.

• LabVIEW Help—Use the LabVIEW Help to access information about LabVIEW 
programming concepts, step-by-step instructions for using LabVIEW, and reference 
information about LabVIEW VIs, functions, palettes, menus, tools, properties, methods, 
events, dialog boxes, and so on. The LabVIEW Help also lists the LabVIEW documentation 
resources available from National Instruments. Access the LabVIEW Help by selecting 
Help»LabVIEW Help.

• Getting Started with LabVIEW—Use this document as a tutorial to familiarize yourself 
with the LabVIEW graphical programming environment and the basic LabVIEW features 
you use to build data acquisition and instrument control applications. Access the Getting 
Started with LabVIEW PDF by selecting Start»All Programs»National Instruments»
LabVIEW»LabVIEW Manuals»LV_Getting_Started.pdf.

• NI PS-16 Power Supply User Manual and Specifications—Use this document to learn 
about the features and specifications of the NI PS-16 power supply and information about 
installing the power supply. 
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protection for electromagnetic compatibility (EMC) and product safety. You can obtain the DoC 
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